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Preface

Thank you for choosing NetScreen-Statistical Report Server, the statistical reporting tool 
for NetScreen-Security Manager.

This NetScreen-Statistical Report Server Administrator’s Guide describes how you can 
configure the Statistical Report Server using the Statistical Report Server-Administration 
Console. This manual also describes how to configure and generate statistical reports 
using the Statistical Report Server Web Interface.

This guide is intended for systems administrators that are responsible for the 
administering, analyzing, and troubleshooting the security infrastructure of their 
organization.
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 Preface
ORGANIZATION
This manual has 4 chapters:

• Chapter 1, “Introducing the Statistical Report Server” provides an introduction 
to NetScreen-Statistical Report Server. It describes the key features and 
benefits of the product.

• Chapter 2, “Configuring the Statistical Report Server” describes how to 
configure the Statistical Report Server using the Statistical Report Server-
Administration Console. This includes a description of how to add and manage 
users of the system, user groups, devices and device groups.

• Chapter 3, “Generating Statistical Reports” describes how to generate reports 
using the Web Interface for Statistical Reports.

• Chapter 4, “Managing the Statistical Report Server Database” describes how to 
maintain the database.
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Juniper Networks Publications
JUNIPER NETWORKS PUBLICATIONS
To obtain technical documentation for any Juniper Networks NetScreen product, visit 
www.juniper.net/techpubs/.

To obtain the latest software version, visit: www.juniper.net/support/. After logging in, 
select the Download Software option, and then follow the displayed instructions. (You 
must be a registered user to download Netscreen software.)

If you find any errors or omissions in the following content, please contact us at the e-mail 
address below:

techpubs-comments@juniper.net
NetScreen-Statistical Report Server 7
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Chapter 1

Introducing the Statistical 
Report Server

In This Chapter

• “Statistical Report Server Overview” on page 2
• “Statistical Report Server and NetScreen-Security Manager” on page 3
• “Accessing the Statistical Report Server” on page 6
• “Next Steps” on page 7

Welcome to NetScreen-Statistical Report Server, the statistical reporting tool for 
NetScreen-Security Manager. You can use the Statistical Report Server to store 
statistical information from the managed FW/VPN devices in your network. You can then 
generate reports from this data enabling you to further view and analyze information 
about your security deployment.
NetScreen-Statistical Report Server 1



Chapter 1 Introducing the Statistical Report Server
STATISTICAL REPORT SERVER OVERVIEW
The Statistical Report Server is composed of two main components:

• Historical Database
• Web Server

The following graphic depicts the two main components of the Statistical Report Server.

Statistical Report Server Historical Database
The Statistical Report Server employs a third party relational database as the central 
repository for all device information that is collected from your network. The Statistical 
Report Server comes installed with a postgreSQL database. It also supports versions of 
Oracle and MS-SQL databases installed to work with previous versions of the Historical 
Report Server, a component of NetScreen Global PRO.

Statistical Report Server Web Server
The Statistical Report Server also includes Tomcat technology which embeds a web server 
enabling you to access and view data on the main database from a web browser.
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Statistical Report Server and NetScreen-Security Manager
STATISTICAL REPORT SERVER AND NETSCREEN-SECURITY 
MANAGER

The Statistical Report Server works in conjunction with NetScreen-Security Manager to 
collect and gather information from the FW/VPN devices managed in your network.

NetScreen-Security Manager Management System
The NetScreen-Security Manager management system is comprised of two main server 
components - the Device Server and GUI Server.

The Device Server is primarily responsible for collecting performance and fault-related 
statistics from each of the managed FW/VPN devices in your network.

The Device Server collects this information in two ways. The Device Server receives 
information that is “pushed” to it from each of the managed FW/VPN devices in your 
network whenever such information becomes available. The Device Server also “polls” 
each of the managed FW/VPN devices in your network periodically to obtain device 
statistics, such as protocol distribution and policy statistics.

The following graphic illustrates how data is collected by the Device Server.
NetScreen-Statistical Report Server 3



Chapter 1 Introducing the Statistical Report Server
Data Pushed From Device to Device Server
The following table lists all the types of data that are “pushed” from each of the managed 
FW/VPN devices in your network to the Device Server

Data Polled By Device Server From Device
The following table lists all the types of data that the Device Server “polls” from each of 
the managed FW/VPN devices in your network:

Pushed Data Description

Traffic Logs Traffic logs are generated when a session has terminated

Traffic Alarms Traffic alarms are generated based on preset thresholds

Attack Alarms Attack alarms are generated based on preset thresholds or 
configuration

Event Alarms Event alarms are related to VPN tunnel events or device events 
such as fan failure, CPU utilization threshold crossed etc.

Configuration Logs Any configuration-related event generates a log.

Information Logs Information logs are related to VPN/IKE or other events that are 
informational.

Self Logs logs of traffic that terminate at the device.

Device Status indicates the up/down status of the device.

Polled Data Description

Protocol Distribution Table Statistics collected on a per interface/vsys basis for bytes and 
packets distribution on a per protocol basis.

Policy Distribution Table Statistics collected on a per policy basis for bytes, packets, and 
number of connections.

Ethernet Statistics Table Statistics collected for each physical interface.

Flow Statistics Table Statistics related to flow level counters on a per virtual interface 
basis

Attack Statistics Table Statistics collected for all the IDS counters on a per virtual 
interface basis

Vpn Monitoring Statistics VPN statistics for each tunnel that includes SA request, 
establishment and teardown times, bytes/packets info, availability, 
latency, users etc.

Nsrp Monitoring Statistics All statistics related to NSRP including VSD and RTO data.

Device Resource Statistics Device resources statistics - Utilization, memory and session-
related statistics for the device

Sa Monitoring Statistics SA statistics and related information used in real-time monitoring.
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Statistical Report Server and NetScreen-Security Manager
Device Server and GUI Server Interaction
The Device Server forwards all of the statistical data polled from the devices to the GUI 
Server.

In the context of the Statistical Report Server, the GUI Server transfers information to 
and from the Device Server to the Statistical Report Server and the Statistical Report 
Server-Administration Console.

The following graphic depicts how the Statistical Report Server and NetScreen-Security 
Manager interact to collect and gather information from the managed FW/VPN devices in 
your network.
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Chapter 1 Introducing the Statistical Report Server
ACCESSING THE STATISTICAL REPORT SERVER
There are two main interfaces enabling you to access the Statistical Report Server:

• “Statistical Report Server-Administration Console” on page 6
• “Statistical Reports Web Interface” on page 6

Statistical Report Server-Administration Console
The Statistical Report Server-Administration Console or Admin Console is a stand-alone 
application that you can install and run on any Windows or Linux-based client machine. 
You use the Admin Console to add and configure information about your FW/VPN devices 
stored on the Statistical Report Server. You can also use also the Admin Console to add 
and manage users of the Statistical Report Server.

Statistical Reports Web Interface
The Statistical Reports Web Interface is a web-based application that you can access 
using any Netscape Navigator 6.0 or Microsoft Internet Explorer 5.0 or above web 
browser. You use the Statistical Reports Web Interface to generate reports from data that 
is stored in the Statistical Report Server.

From the Statistical Report Web Interface, you can choose from a selection of over 40 
reports to view and analyze network traffic, device and VPN statistics, system resources, 
and other administrative information. You can also customize and generate commonly-
used reports on a regularly scheduled basis.
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Next Steps
NEXT STEPS
This chapter has provided you with the following:

• a brief overview of the Statistical Report Server
• a description of how Statistical Report Server works with NetScreen-Security 

Manager to collect and gather data from the managed FW/VPN devices in your 
network

• a description of how to access the Statistical Report Server using the Statistical 
Report Server-Administration Console and the Statistical Report Web Interface

Refer to Chapter 2, “Configuring the Statistical Report Server” for more specific 
information describing how to use the Statistical Report Server-Administration Console 
to add and configure users, user groups, devices, device groups, and the Device Server in 
the Statistical Report Server.

Refer to Chapter 3, “Generating Statistical Reports” for more specific information 
describing how to use the Statistical Reports Web Interface to generate statistical reports 
for NetScreen-Security Manager.

Refer to Chapter 4, “Managing the Statistical Report Server Database” for more specific 
information describing how to maintain the Statistical Report Server historical database.
NetScreen-Statistical Report Server 7
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Chapter 2

Configuring the Statistical 
Report Server

In This Chapter

• “Using the Statistical Report Server-Administration Console” on page 10
• “Statistical Report Server Configuration Overview” on page 13
• “Adding and Configuring Users” on page 14
• “Managing Users With User Groups” on page 19
• “Adding and Configuring the Device Server” on page 21
• “Adding and Configuring Devices” on page 23
• “Managing Devices Using Device Groups” on page 27
• “Exiting the Admin Console” on page 29

The Statistical Report Server provides you the flexibility to configure and manage the 
system to work the way you want. From the Statistical Report Server-Administration 
Console, you can add, configure and manage all the users, and devices in your Statistical 
Report Server from a central location.
NetScreen-Statistical Report Server 9



Chapter 2 Configuring the Statistical Report Server
USING THE STATISTICAL REPORT SERVER-ADMINISTRATION 
CONSOLE

The Statistical Report Server-Administration Console or Admin Console provides you 
with a central location from which you can administer and manage all users, user groups, 
Device Servers, devices and device groups in the Statistical Report Server.

About the Admin Console
The Admin Console has the following main components:

Admin Console toolbar

Connection Status indicator
Current user login status

Control Pane List Pane Details Pane
10 Administrator’s Guide



Using the Statistical Report Server-Administration Console
Admin Console Toolbar
The Admin Console toolbar provides easy access to operations you will commonly perform 
such as adding or deleting objects in the Statistical Report Server. The Admin Console 
toolbar also provides easy access to perform the following operations:

• Add - click on the Add icon to quickly add an object
• Delete - click on the Delete icon to quickly delete an object
• Refresh - click on the Refresh icon to refresh the Admin Console display 

enabling you to view your more recent changes
• Logout - click on the Logout icon to quickly close your current Admin 

Console user session
• Help - click on the Help icon  to quickly access the Admin Console online 

help utility
• Save - click on the Save icon to save your most recent configuration changes
• Revert - click on the Revert icon to undo changes

Control Pane
Use the Admin Console control pane to access the main objects that you can configure in 
the Statistical Report Server including User Group, User, Device Server, Device, and 
Device Group.

By clicking on the appropriate control pane button, the List Pane and Details Pane for 
that object appear.

List Pane
The List Pane displays and provides access to objects that are already created in the 
Statistical Report Server. Click on the object that appears in the List Pane and all the 
information that has been already configured for that object appears in the Details Pane.

Details Pane
The Details Pane displays and enables you to configure individual objects in the 
Statistical Report Server.
NetScreen-Statistical Report Server 11



Chapter 2 Configuring the Statistical Report Server
Status Indicators
There are two main status indicators located on the bottom of the Admin Console. The 
User status indicator displays the current user account that is logged into the system as 
well as the IP Address of the Statistical Report Server. The Connection status indicator 
displays whether or not the user is currently connected to the system.

Setting Preferences
You can configure the appearance of the Admin Console to suit your preference. Use the 
Tools menu and select Preferences to change both the theme and font size of the Admin 
Console interface.

Use the theme pull-down menu to change the overall color scheme of the Admin Console. 
Use the font pull-down menu to increase or decrease the font size of all titles that appear 
in the Admin Console interface.

Getting Help
If at any time, you need help using the Admin Console, you can access the online help 
facility, by using the Help menu and selecting Help Topics. Alternatively, you can click 
on the help button that appears in the Admin Console toolbar. The Admin Console 
online help appears in a separate window. Click on the one of the topics in the table of 
contents or use the Index to find a specific answer to your question.

For more context sensitive help, click on any of the help buttons that appear in the Admin 
Console.

Logging Out of the Admin Console
Use the File menu and select Logout, or alternatively, click on the Logout icon in 
the Admin Console toolbar, to close your current user session in the Admin Console.
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Statistical Report Server Configuration Overview
STATISTICAL REPORT SERVER CONFIGURATION OVERVIEW
The general process for configuring the Statistical Report Server is as follows:

Setting Up Users
Anyone that wants to use the Statistical Report Server must have a valid user name and 
password in the Statistical Report Server system. Refer to “Adding and Configuring 
Users” on page 14 for more information.

Once you have created your users, you can then group them logically in any number of 
ways depending on their department, job function or administrator role. Refer to 
“Managing Users With User Groups” on page 19 for more information on configuring 
users into user groups.

Setting Up the Database
After you have setup your users, you are ready to begin populating the historical database 
with information about your network. This process starts with creating and configuring 
the Device Server. The Device Server in NetScreen-Security Manager plays a key role in 
collecting data from the FW/VPN devices managed in your network. You must add the 
primary and if applicable secondary, Device Server to the Statistical Report Server before 
adding your devices. This is because each device must be associated with a primary 
Device Server so that data collection can begin. Refer to “Adding and Configuring the 
Device Server” on page 21 for more information on creating and configuring the Device 
Server.

After you have created and configured the Device Server, you can add and configure 
information about the FW/VPN devices managed in your network. All of the data in the 
Statistical Report Server is by design, associated with a specific FW/VPN device in your 
network. Before you begin to collect data from your network, you must first create a 
device object in the Statistical Report Server database for each of the managed FW/VPN 
devices in your network that you want to collect data from. Refer to “Adding and 
Configuring Devices” on page 23 for more information

Just like users, you can organize devices into logical groupings called Device Groups. You 
can group your devices in any number of ways depending on their region, customer 
relationship, service level, security level. Refer to “Managing Devices Using Device 
Groups” on page 27 for more information on configuring device groups.

Note: Any data collected from a FW/VPN device that is not yet created in the Statistical 
Report Server database, is rejected by the Statistical Report Server.
NetScreen-Statistical Report Server 13



Chapter 2 Configuring the Statistical Report Server
ADDING AND CONFIGURING USERS
Your first task as the initial Statistical Report Server default user is to create a unique 
User Name and Password for yourself.

Adding a User
To add a user:

1. Click on the User button in the Control pane. The Admin Console displays a list 
of all current users created in the system in the List pane.

2. Use the Edit menu, and select Add. Alternatively, you can click on the Add icon 
that appears in the Admin Console tool bar. A template enabling you to 

configure details for a new user appears in the Details pane.
3. Enter a user name for the user.
4. Assign the user a password and re-enter it in the Confirmed Password field.
5. Enter any appropriate contact information (optional).
6. Click on the Save icon in the Admin Console toolbar to save your changes. 

The user now appears in the List pane. Or, click on the Revert icon to cancel 
your changes.

You can later configure additional properties for the user including specific report access 
or administrative privileges and group assignments. Refer to “User Privileges” on page 15 
for more information.

Configuring a User
After you have added a user to the system, you can configure the following properties:

• Privileges - you must assign a user specific privileges to view statistical reports 
or to perform administrative functions. Refer to “User Privileges” on page 15 for 
more information.

• Access to Devices and Virtual Systems - you must also provide the user 
access to the devices and virtual systems from which data in the system 
originates. Refer to “Assigning User Access to a Device and Virtual System” on 
page 17 for more information.

• Access to Device Groups - if you are dealing with large numbers of devices, 
you will want to create device groups. Device groups enable you to manage user 
access to multiple devices more efficiently. Refer to “Managing Devices Using 
Device Groups” on page 27 for more information.

• Assignment to a User Group - if you are dealing with large numbers of users, 
you will want to create and manage your users in User Groups. Refer to 
“Managing Users With User Groups” on page 19 for more information.

Note: The users that you create in the Statistical Report Server are valid in the Statistical 
Report Server system only. They are not to be confused with Admins or other users that 
you create in NetScreen-Security Manager.
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Adding and Configuring Users
User Privileges
You can grant a user privileges to view certain statistical reports or to perform certain 
administrative actions. Individual user privileges allow you to extend a specific user’s 
privileges beyond those privileges the user inherits from its membership in a group.

There are two types of privileges that you may assign to a user or group:

• Administrative Privileges
• Report Viewing Privileges

Report Viewing Privileges
The most common set of privileges that you can grant to a user are privileges to view 
statistical reports. You can grant a user privileges to view individual reports or categories 
of reports. The following report categories are available in the Statistical Report Server:

• Network Traffic
• Service Level Agreements
• Resources
• Administration

Administrative Privileges
You can also assign privileges to perform certain administrative functions. For example, if 
you wanted to enable others to be administrators of the Statistical Report Server, you 
could create an account, and assign them administrative privileges such as creating 
additional users.

The following table describes administrative privileges that you can assign to a user or 
group:

Assigning User Privileges
To assign or modify user privileges:

Privilege Allows a user to...

Administer Database perform tasks on the database. This includes the ability to perform 
database cleanup operations (i.e., archive and purge records). 
Refer to “Managing the Database” on page 50 for more information.

Create User/Group Add, delete or modify users and group profiles. Also allows association 
of users to groups (i.e., adding and deleting users to and from a group.

Assign Privilege Assign privileges to users and groups in the Admin Console.

Add/Delete Device/Device 
Server

Add, delete, or modify a device or Device Server in the Admin Console.
NetScreen-Statistical Report Server 15



Chapter 2 Configuring the Statistical Report Server
1. Click on the User button in the Control pane. The Admin Console displays a list 
of all current users created in the system in the List pane.

2. Select the desired user from the List pane. The user’s profile appears in the 
Details pane.

3. Check the checkbox corresponding to the privileges that you wish to assign to 
the user in the Administrative Privileges section. Similarly, you can uncheck the 
checkbox corresponding to the privileges that you wish to deny the user.

4. From the Report Privileges section, click the + button to expand the report 
category list. A list of the report names for the report category appears with the 
corresponding read privileges. Check the corresponding checkbox(es) to assign 
read privileges on the selected report. Similarly, you can uncheck the 
corresponding checkbox(es) to deny read privileges on the selected report.

5. Click on the Save icon in the Admin Console tool bar to save your changes. Or, 
click the Revert icon to cancel your changes.
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Adding and Configuring Users
Assigning User Access to a Device and Virtual System
You will also need to assign a user to the appropriate device(s) and/or virtual system(s) 
allowing the user to access report information generated by that object.

To assign a user to a device:

1. Click on the User button in the Control pane. The Admin Console displays a list 
of all current users created in the system in the List pane.

2. Select the desired user from the List pane. The user’s profile appears in the 
Details pane.

3. Click on the Devices tab.
4. Select the device(s) that you want the user to access from the list of Available 

Devices, and then click on the Add button. The device(s) that you selected now 
appears in the list of Selected Devices.

In a similar manner, you can use the Virtual Systems tab and add the virtual 
system(s) that you want the user to access to the list of Selected Virtual 
Systems.

5. Use the Delete button to remove devices and/or virtual systems from the list of 
Selected Devices. The device and/or virtual system now reappears in the list of 
Available Devices/Virtual Systems.

6. Click on the Save button in the Admin Console tool bar to save your changes. 
Or, click the Revert button to cancel your changes.
NetScreen-Statistical Report Server 17
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Viewing All Users
Once you add a user in the Statistical Report Server, the Admin Console stores all the 
information that you have configured for the user in the database. You can view a list of 
all users in the Statistical Report Server system by generating an All User report from the 
Statistical Reports Web Interface.

Refer to “Using Administration Reports” on page 41 for more information on the All Users 
report.

Deleting a User
On occasion, it may become necessary to delete a user from the Statistical Report Server.

To delete a user:

1. Click on the User button in the Control pane.
2. Select the desired user from the List pane. The user’s profile appears in the 

Details pane.
3. Click on the Delete button. Alternatively, you can right-click in the List pane 

and select Delete. You can also click on the Edit menu and select Delete. A 
message appears asking you to confirm your choice.

4. Confirm your selection, and then click Yes
5. Click on the Save icon in the Admin Console tool bar to save your changes. Or, 

click the Revert icon to cancel your changes.
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MANAGING USERS WITH USER GROUPS
It is recommended that you begin adding and configuring your users in the Statistical 
Report Server by first organizing them into logical groupings.

Adding a Group
To add a group:

1. Click on the User Group button in the Control pane. The Admin Console 
displays a list of all current user groups created in the system in the List pane.

2. Click on the Add button. You can also click on the Edit menu and select Add. A 
template appears in the Details pane enabling you to configure a group.

3. Enter a name for the group in the Group name field. You can optionally enter a 
description of the group in the Information field.

4. Click on the Save icon in the Admin Console toolbar to save your changes. The 
group now appears in the List pane. Or, click on the Revert icon to cancel your 
changes.

Assigning a User to a Group
Once you have created and configured your user groups, you can assign users to them. 
You can assign a user to as many user groups as you want.

1. Click on the User Group button in the Control pane. The Admin Console 
displays a list of all current groups created in the system in the List pane.

2. Select the desired group from the List pane. The user group’s profile appears in 
the Details pane.

3. Select the Users tab.
4. Select the desired user from the list of Available Users and click the Add button. 

The user now appears in the list of Selected Users. 

The user’s privileges change when adding or removing groups with differing 
privileges associated with them.

5. Click on the Save icon in the Admin Console tool bar to save your changes. Or, 
click the Revert icon to cancel your changes.

Removing a User from a Group
The process of removing a user from a group is similar to the procedure described for 
assigning a user to a group. To remove a user from a group, use the Delete button in the 
Users tab to delete the user from the list of Selected Users.

Note: To select multiple users, use the [Shift] key (to select users appearing 
together), or [Ctrl] key (to select users that do not appear together).
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Assigning Privileges to a User Group
Once you have added a group, you can now assign specific privileges to that group. As you 
assign users to the group, those users will effectively inherit the privileges assigned to the 
group. For example, let’s say you create a group called Engineering and assign “Create 
User/Group” privileges to it; you later assign a user named Jack to that group. Jack now 
effectively inherits the “Create User/Group” privilege.

Users who are assigned to more than one group will inherit the collective privileges of all 
the groups that they are assigned. For example, let’s say you assign “Create User/Group” 
privileges to those users in the Engineering group; and you also assign “Assign Privilege” 
privileges to those users in the Marketing group. If you assign Jack to both the 
Engineering and Marketing groups, he inherits both Create User/Group and Assign 
Privilege privileges.

Use the Privileges tab to assign specific report viewing or administrative privileges to a 
group.

Assigning a Device to a User Group
You must also assign a specific device or devices to a User Group in order for that group to 
access information about that device(s).

1. Click on the User Group button in the Control pane.
2. Select the desired group from the List pane. The user group’s profile appears in 

the Details pane.
3. Select the Devices tab in the Details pane. The Admin Console lists the 

available devices with the following device information: Device Name, Serial 
Number, Device Type, Device IP Address.

4. Select a device from the list of Available Devices, and then click on the Add 
button. The device now appears in the list of Selected Devices.

5. To remove a device, select it from the list of Selected Devices and click Delete. 
The device now appears in the list of Available Devices.

6. Click on the Save icon in the Admin Console tool bar to save your changes. Or, 
click the Revert icon to cancel your changes.

Assigning a Group to a Virtual System
In a similar manner, you can use the Virtual Systems tab in the Details pane to assign a 
virtual system to a Device Group.

Viewing All Groups
You can view a list of all groups in the Statistical Report Server by generating an All 
Groups report from the Statistical Reports Web Interface.

Refer to “Using Administration Reports” on page 41 for more information on the All 
Groups report.
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ADDING AND CONFIGURING THE DEVICE SERVER
The Statistical Report Server uses the Device Server to gather real-time performance 
statistics, and other traffic-related information from the FW/VPN devices that you are 
managing in your network.

You must add the primary and if applicable secondary, Device Server to the Statistical 
Report Server before adding your devices. This is because each device must be associated 
with a primary Device Server so that data collection can begin.

Adding a Device Server
To add a Device Server:

1. Click on the Device Server button in the Control pane. The Admin Console 
displays a list of all current Device Servers created in the system in the List 
pane.

2. Click on the Add button. Alternatively, you can right-click in the List pane, and 
select Add. You can also click on the Edit menu and select Add. A template 
appears in the Details pane enabling you to configure a Device Server.

3. Enter a name for the Device Server in the name field.
4. Enter the IP Address of the Device Server in the IP address field.
5. Enter the Mapped IP Address of the Device Server (if applicable). For example, 

you may need to enter the Mapped IP Address in the event that your Device 
Server is located on a computer behind a firewall.

6. Use the Contact Person pull-down menu to select a contact person for the Device 
Server from the list of the existing users in the Statistical Report Server 
(optional).

7. Enter the GUI Server IP Address.
8. Click on the Save icon in the Admin Console toolbar to save your changes. The 

Device Server now appears in the List pane. Or, click on the Revert icon to 
cancel your changes.

Viewing the Device Server
Click to select the Device Server, and you can view additional information about it in the 
Details pane. Double-click on the Device Server to view the devices for which the Device 
Server serves as either the primary or secondary.

Associated Device Summary
You can obtain additional information describing the FW/VPN devices assigned to the 
Device Server by selecting the device associated with that Device Server. Information 
about the device appears in the Details pane.
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The following table describes the device information available from the Device Summary.

Deleting a Device Server
There are occasions in which you might need to delete a Device Server, for example, if you 
want to “relocate” a Device Server, or bring down a Device Server for adding memory or 
backing up a system.

1. Verify that you have stopped Device Server.
2. Select the Device Server that you want to delete in the List pane. 
3. Click on the Delete icon in the Admin Console tool bar. Alternatively, you can 

also right-click on a Device Server in the List pane and select Delete. A dialog 
box asks you to confirm the deletion.

4. Verify that you have selected the correct Device Server, and then click Yes.

Item Description
Serial Number Serial number of the FW/VPN device.
Firmware Version Version information describing the version of ScreenOS running on the device.
Host Name FW/VPN device host name.
IP Address IP address of the FW/VPN device.
Domain Name Only present if a domain name is configured on the device, for example, 

juniper.net.
Description A description of the device.
Comments Comments that were included when the device was added to the Admin 

Console.

Warning: This operation cannot be undone. When you delete a Device Server, all the 
devices sending data to the Device Server will stop doing so. You must create new 
associations with another Device Server before you delete the Device Server.
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ADDING AND CONFIGURING DEVICES
Use the Admin Console to first add, and then configure your devices. To add a device you 
will need to enter basic information identifying it (i.e., serial #, user name and password). 
You will also need to assign it to a Primary Device Server, and Secondary Device Server 
(if applicable).

If you wish to add multiple devices, there are several options that you can use:

• “Importing a Device List” on page 23
• “Importing Device Information from a Text File” on page 23

Importing a Device List
You can import information describing the managed FW/VPN devices in your network 
using a device list. A device list is a file exported from NetScreen-Global PRO Policy 
Manager that contains information about your FW/VPN devices.

To import a device list:

1. From the File menu, select Import Device List. The Import Configuration 
Dialog window appears.

2. Click in the Telnet or SCS checkbox to select a method with which to 
communicate with the devices for importing configuration information.

3. Click on the Start Import button. A window appears enabling you to browse to 
the device list file.

4. Browse to the device list file and open it. The serial numbers and IP addresses of 
all the devices in the device list appear in the Devices field with a corresponding 
import result. The status of the operation, for each device imported, is displayed 
in the Result field. Any errors that may have occurred during the import are 
displayed in the Error Description field.

5. Click Close when you are done.

Importing Device Information from a Text File
You can also import a device list from a text file. If you are creating a text file to import 
device information into the Statistical Report Server, enter the following information on a 
single line for each device:

• Serial Number
• Primary Device Server
• Secondary Device Server
• IP Address
• User Name
• Password

For example you would create the following entry:
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SN=03000203,HN=ns100,PDC=10.150.41.233,SDC=172.16.10.250,IP=1
0.150.41.232,User=netscreen,Password=netscreen

Note that it is not necessary to populate every field. For example, you could create the 
following entries:

IP=10.150.41.232,User=netscreen,Password=netscreen

SN=03000203,HN=,PDC=10.150.41.233,SDC=,IP=,User=,Password=

SN=03000203,HN=ns100,PDC=10.150.41.233,SDC=10.150.41.240,IP= 
10.150.41.232,User=netscreen,Password=netscreen

Configuring Mapped IP Addresses
If your Device Server is located on a computer behind a firewall you will need to provide 
the mapped IP address for the Device Server. The mapped IP file uses the following 
format:

Original IP Address = Mapped IP Address

For example: 10.150.12.24 = 192.111.23.25

To automatically map a Device Server’s IP address:

1. From the Import Device List window, click in the Use Mapped IP for Device 
Server checkbox. The Load Map File button appears active.

2. Click on the Load Map File button. A window will appear allowing you to 
browse to the map file.

3. Browse to the map file and open it. The Import Configuration Dialog reappears.
4. Click on the Start Import button to import the file.

When the import completes, Statistical Report Server adds the original IP address and 
the mapped IP address to the device, and communicates with the device to import the 
data needed from it. Once it reads the information, it adds the device to the Statistical 
Report Server.

Adding a Device
You can also add devices to the Statistical Report Server one at a time.

To add a device:

1. Click on the Device button in the Control pane. The Admin Console displays a 
list of all current devices created in the system in the List pane.

2. Click on the Add button. Alternatively, you can right-click in the List pane, and 
select Add. You can also click on the Edit menu and select Add. A template 
appears in the Details pane enabling you to configure a device.

3. Enter the Serial number of the device in the field provided.
4. Enter the User Name of the device in the field provided.
5. Enter the Password of the device in the field provided. Confirm the password.
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6. Use the Contact Administrator pull-down menu to select a contact person for the 
Device Server from the list of the existing users in the Statistical Report Server 
(optional).

7. Enter any additional comments (optional).
8. Use the Primary Device Server pull-down menu to assign the device to its 

Primary Device Server from the list of the existing Device Servers in the 
Statistical Report Server.

9. Use the Secondary Device Server pull-down menu to assign the device to a 
Secondary Device Server from the list of the existing Device Servers in the 
Statistical Report Server, if applicable.

10. Click on the Save icon in the Admin Console toolbar to save your changes. The 
group now appears in the List pane. Or, click on the Revert icon to cancel your 
changes.

Viewing All Devices
Once you add a device in the Statistical Report Server, the Statistical Report Server 
stores all the information that you have configured for the device in the database. You can 
view a list of all devices in the Statistical Report Server system by generating an All 
Device Information report from the Statistical Reports Web Interface.

Refer to “Using Administration Reports” on page 41 in for more information.

Exporting a Device List
Exporting a device list enables you to keep a copy of your current device list in case you 
need it later to import.

1. From the File menu, select Export Device List. A window appears allowing 
you to browse to a destination directory where you want to save the export list.

2. Browse to the desired file and click Save.

Deleting a Device
On occasion, it may become necessary to delete a device from the Statistical Report 
Server.

To delete a device:

1. Click on the Device button in the Control pane. The Statistical Report Server 
displays a list of all current devices created in the system in the List pane.

2. Select the device that you want to delete from the List pane.
3. Click on the Delete icon in the Admin Console toolbar. Alternatively, you can 

also delete a device by right-clicking in the List pane and selecting Delete; or by 
using the Edit menu and selecting Delete. A message appears asking you to 
confirm your choice.
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4. Confirm your selection, and then click Yes.

Note: Deleting a device from the Statistical Report Server will not effectively 
remove the device from the database
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MANAGING DEVICES USING DEVICE GROUPS
Once you have added your devices, you can then map them into logical groupings. This 
enables you to more easily view and manage your devices in the Statistical Report Server. 
To do this, use the Admin Console to add device groups and then assign your devices to 
them. For example, you could create a device group for the devices that you have 
implemented for each customer or region. You can later assign privileges to specific users 
allowing them access to their own groups.

Adding a Device Group
1. Click on the Device Group button in the Control pane. The Statistical Report 

Server displays a list of all current Device Groups created in the system in the 
List pane.

2. Click the Add button in the Admin Console tool bar. Alternatively, you can 
right-click in the List pane and select Add. You can also click on the Edit menu 
and select Add. A template allowing you to configure a new Device Group 
appears in the Details pane.

3. Enter any applicable information in the Contacts tab.
4. Click on the Save icon in the Admin Console toolbar to save your changes. The 

device group now appears in the List pane. Or, click on the Revert icon to cancel 
your changes.

Assigning a Device or Virtual System to a Device 
Group

1. Select a Device Group from the List pane.
2. Click on the Device tab. Select the devices that you want to add to the Device 

Group from the list of available devices. Click on the Add button to add them. 
The device(s) now appears in the list of Selected Devices.

3. Click on the Virtual Systems tab. Select the virtual systems that you want to 
add to the Device Group from the list of Available Virtual Systems. Click on the 
Add button to add them. The virtual system(s) now appears in the list of 
Selected Virtual Systems.

4. Click on the Save icon in the Admin Console toolbar to save your changes. The 
device group now appears in the List pane. Or, click on the Revert icon to cancel 
your changes.
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Removing a Device or Virtual System from a Device 
Group

The process of removing a device or virtual system from a Device Group is similar to the 
procedure described for assigning a device/virtual system to a device group. To remove a 
device/virtual system from a device group, use the Remove button in the Devices or 
Virtual Systems tab to remove the device/virtual system from the list of Selected Devices/
Virtual Systems.

Deleting Device Groups
1. Click on the Device Group button in the Control pane. The Statistical Report 

Server displays a list of all current device groups created in the system in the 
List pane.

2. Click on the Delete icon in the Admin Console tool bar. Alternatively, you can 
also delete a device group by right-clicking in the List pane and selecting 
Delete; or by using the Edit menu and selecting Delete. A message appears 
asking you to confirm your choice.

3. Confirm your selection, and then click Yes.

Warning: Deleting a Device Group will not delete any device history in the database.
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EXITING THE ADMIN CONSOLE
When you are done using the Admin Console, you can exit the application as follows:

1. From the File menu, select Exit. The Admin Console prompts you to confirm 
that you want to exit.

2. Click Yes to confirm that you want to exit.
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Chapter 3

Generating Statistical Reports
In This Chapter

• “Using the Statistical Reports Web Interface” on page 32
• “Report Categories” on page 36
• “Using Network Traffic Reports” on page 38
• “Using Service Level Agreement Reports” on page 39
• “Using Resource Reports” on page 40
• “Using Administration Reports” on page 41
• “Generating Reports Automatically” on page 42
• “Viewing Reports” on page 45
• “Exporting Reports” on page 48

This chapter describes the Statistical Report Web Interface and how you can use it to 
configure and generate statistical reports enabling you to view and analyze data about the 
managed FW/VPN devices in your network.
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USING THE STATISTICAL REPORTS WEB INTERFACE
You can access the Statistical Report Server from any Netscape Navigator 6.0 or higher, 
or Internet Explorer 6.0 or higher web browser.

1. Launch any web browser.
2. Enter the address and port number for the Statistical Report Server in the 

Address bar of your browser. Depending on the port selected, enter the following 
address: https://<IP address:HTTPS Port>/reports/where <IP address:Port> is 
the machine IP address/Port number of the report server, and Reports is the 
virtual directory. The HTTPS port provides secure access.

For example, if the IP Address of the Statistical Report Server is 10.150.12.345, 
and the port number is 443, you would enter the following in your browser 
address bar:

https://10.150.12.345:443/reports

This takes you to the Statistical Reports login page.

3. In the Login window, enter your Statistical Report Server User Name and 
Password, and click Login.

Note: You will need to have created a user in the Statistical Report Server before 
you login. If you do not already have a user in the Statistical Report Server, 
contact your system administrator to create one for you.
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After you have successfully logged in, you will be taken to the Statistical Reports 
Web Interface Home page.

Use the Statistical Report Web Interface to create reports detailing information 
about the managed FW/VPN devices in your network.

About the Statistical Reports Web Interface
The Statistical Reports Web Interface has three main sections:

• Category/Reports Pane

• Report Context Pane

• Report Parameters Pane
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Category/Reports Pane
Use the Category/Reports pane to access the report selection drop-down list. Click on the 
green “down” arrow to select the report category. From the selected category reports list, 
click on the specific report that you want to generate.

Report Context Pane
Use the Report Context pane to select the device(s), device group(s), virtual system(s), or 
cluster(s) that you wish to generate a report on. Click the plus/minus sign to expand or 
collapse the hierarchy or tree. You can select multiple devices or multiple groups in a 
cluster by clicking each object.

Report Parameters Pane
Use the Report Parameters pane to configure the date, time, sampling duration and any 
other parameters for your report. The Report Parameters pane offers a variety of options 
you can use to generate your reports. These options vary depending on the type of report 
that you select. Note that the dates and hours feature varies according to the type of 
report you choose to generate.

The Sampling Duration choices allow you to view reports for a specified time period. You 
can select hourly, daily, weekly, or monthly intervals. You also have the option of 
sampling the entire duration by selecting All. For example, if you generate a report for the 
last two months, you can select to view information within those two months either by 
month, by week, by day, or by hour.

Getting Help
If you need help using the Statistical Reports Web Interface, click on the help button that 
appears in the Statistical Reports Web Interface toolbar. The Statistical Reports online 
help appears in a separate window. 
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GENERATING A REPORT
Use the Statistical Reports Web Interface to customize and generate reports enabling you 
to analyze information about the managed FW/VPN devices in your network.

You can access 40 reports. These reports are grouped into six categories:

• Network Traffic
• Service Level Agreements
• Resources
• Administration

To generate a report:

1. In the Category/Reports pane, use the Category/Reports navigation tree to 
select a report category. The list of available reports appears.

2. Click to select a specific report from the reports list. 
3. In the Report Context pane, select the device group(s), device(s), or virtual 

system(s), that you wish to generate a report on.
4. In the Report Parameters pane, enter a specific period of time to and from which 

you wish to generate the report for. Use the date/time format icon to toggle the 
way the Statistical Reports Web Interface displays the date and time between 
US and European formats. Use the calendar icon to select a date.

5. Enter a sampling duration. You can select to sample either hourly, daily, 
weekly, or monthly.

6. Enter any other parameters that may be applicable for the report.
7. Click on the Report button in the Toolbar. This generates the report and 

displays it.

From the Statistical Reports Web Interface, you can also create report templates or 
profiles to generate report(s) automatically. The Statistical Report Server sends you an e-
mail notifying you when reports are available for viewing.
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REPORT CATEGORIES
You can access 40 reports from the Statistical Report Web Interface. The reports are 
arranged in the following order:

Report Category Reports

Network Traffic(6) Ethernet Statistics Summary
Flow Statistics Summary
Policy Statistics Summary
Protocol Statistics Summary
Cluster Ethernet Statistics Summary
Cluster Flow Statistics Summary

Service Level 
Agreement(14)

Device Uptime/Downtime Statistics
VPN Uptime/Downtime Statistics
VPN Availability Statistics
VPN Average Latency Statistics
VPN Total Uptime/Downtime Statistics
VPN Total Number Of Users
VPN Total Throughput Statistics
VPN Total Throughput By User
VPN Total Throughput By Type
VPN Total Throughput By Group
Cluster /VSD Group Uptime/Downtime Statistics
VSD Group Uptime/Downtime Statistics By Cluster
VSD Counter Statistics By Cluster
Packet Forwarding Counter Statistics By Cluster

Resources(8) Ethernet Interface Utilization
Device CPU Utilization Statistics
Device Memory Allocation Statistics
Device Session Statistics
Cluster Ethernet Interface Utilization
Cluster Device CPU Utilization Statistics
Cluster Member Memory Allocation Statistics
Cluster Member Session Statistics
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Report Categories
Administration(12) All Groups
All Users
Users And Groups Managing A Device
Users And Groups Managing A Device Group
Device Inventory By User and Configuration
All Device Information
All Device / Vsys/ Interface Summary
User Cluster Information Summary
Cluster VSD Group Information Summary
Cluster RTO Group Information Summary
Device Event Distribution Overview
Event Distribution Overview

Report Category Reports
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USING NETWORK TRAFFIC REPORTS
Network Traffic Reports enable you to summarize and analyze the type of network traffic 
for a device, group of devices, cluster of devices, or clusters in a group. This category 
contains all network traffic-related reports.

The following table lists and describes the Network Traffic reports that you can generate:

Category Description

Ethernet Statistics 
Summary

Displays a synopsis of the Ethernet network traffic running on your network. 
Data includes, Bytes In/Out, Collisions, etc.

Flow Statistics 
Summary

Displays a synopsis of the flow network traffic running on your network. Data 
includes, VLAN In/Out, Packets sent, etc.

Policy Statistics 
Summary

Displays a synopsis of the policy-based network traffic running on your 
network. Data may include, Bytes, Packets, and Collisions.

Protocol Statistics 
Summary

Displays a synopsis of the protocol-based network traffic running on your 
network. Data may include, Bytes, Packets, and Collisions.

Cluster Ethernet 
Statistics Summary

Displays a synopsis of the Ethernet traffic running on clusters and their device 
members. 

Cluster Flow 
Statistics Summary

Displays a synopsis of the flow traffic running on clusters and their device 
members. 
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USING SERVICE LEVEL AGREEMENT REPORTS
Service Level Agreement (SLA) reports enable you to summarize and analyze data related 
to VPN and device uptime/downtime. Additionally, it provides reports for VPN 
throughput analysis, latency, availability and remote user distribution as well as reports 
for High Availability.

The following table lists and describes the Service Level Agreement reports that you can 
generate:

Category Description

Device Uptime/Downtime 
Statistics

Displays a statistical summary of the uptime/downtime of the 
device(s).

VPN Uptime/Downtime 
Statistics

Displays a statistical summary of the uptime/downtime on VPNs 
associated with specific devices.

VPN Availability Statistics Displays a statistical summary of the availability of VPNs associated 
with specific devices.

VPN Average Latency Statistics Displays a statistical summary of the latency on VPNs associated 
with specific devices.

VPN Total Uptime/Downtime 
Statistics

Displays a statistical summary of the total uptime/downtime of a 
selected VPN.

VPN Total Number Of Users Displays data on the total user count for a selected VPN.

VPN Total Throughput Statistics Displays a statistical summary of the total throughput (both user and 
type) for a selected VPN.

VPN Total Throughput By User Displays a statistical summary of the user throughput (only) for a 
selected VPN.

VPN Total Throughput By Type Displays a statistical summary of the type throughput (only) for a 
selected VPN.

VPN Total Throughput By Group Displays a statistical summary of the throughput sorted by group for a 
selected VPN.

Cluster/VSD Group Uptime/
Downtime Statistics

Displays a statistical uptime/downtime summary for clusters or VSDs 
(virtual security devices)

VSD Group Uptime/Downtime 
Statistics By Cluster

Displays the total uptime/downtime for clusters or VSDs.

VSD Counter Statistics By 
Cluster

Displays a statistical counter for clusters.

Packet Forwarding Counter 
Statistics By Cluster

Displays a statistical counter of the packets forwarded for clusters.
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USING RESOURCE REPORTS
Resource reports enable you to review the resources used on a network. All device side 
statistics are available in this category. You can generate a Resource report on either a 
per device(s), per device group, or per cluster(s) basis.

The following table displays the Resource reports that you can generate:

Category Description
Ethernet Interface Utilization Displays the average Ethernet usage for a 

device or a device group. Data appears in 
percentages.

Device CPU Utilization Statistics Displays a statistical summary of the average 
CPU utilization for a device or a device group. 

Device Memory Allocation Statistics Displays a statistical summary of the memory 
allocation for a device or a device group. 

Device Session Statistics Displays a statistical summary of the session 
statistics of a device or a device group. 

Cluster Ethernet Interface Utilization Displays the average Ethernet usage for a 
cluster. Data appears in percentages.

Cluster Device CPU Utilization Statistics Displays a statistical summary of the average 
CPU utilization for a cluster.

Cluster Member Memory Allocation Statistics Displays a statistical summary of the memory 
allocation for a cluster.

Cluster Member Session Statistics Displays a statistical summary of the session 
statistics for members of a cluster.
40 Administrator’s Guide



Using Administration Reports
USING ADMINISTRATION REPORTS
You can generate Administration reports to help you view and manage all the groups, 
users, clusters and devices in your Statistical Report Server system.

The following table displays the Administration reports that you can generate.

Warning: Access to the data (i.e., All Groups, Users etc...) that you can view on the 
Administration Reports is not restricted to a user’s role-based privileges in the Statistical 
Report Server. So, for example, if a user can access the Administration Reports, he or she 
can generate a report and view data configured in the Statistical Report Server system 
regardless of whether they are an administrator or not. To control access to the data in the 
Administration Reports, it is recommended that you disable read privileges to the 
Administration Reports to all users except for your authorized server administrator. Refer 
to “Assigning Privileges to a User Group” on page 20 for more information.

Category Description

All Groups Displays information on all groups within a given network.

All Users Displays information on all users within a given network.

Users And Groups Managing a 
Device

Displays information on the users and groups managing a given 
device.

Users and Groups Managing a 
Device Group

Displays information on the users and groups managing a given 
device group.

Device Inventory By User And 
Device Group

Displays a device inventory by user and device group.

All Device Information Displays all the data on all devices in a given network.

All Device/Vsys/Interface 
Summary

Displays a summary of the devices, Vsys, and interfaces in a given 
network.

User Cluster Information Summary Displays a summary of all user cluster information.

Cluster VSD Group Information 
Summary

Displays a summary of cluster information network for a VSD 
(Virtual Security Device).

Cluster RTO Group Information 
Summary

Displays a summary of cluster information network for a RTO (Run 
Time Object).

Device Event Distribution 
Overview

Displays total number of events occurring on each NetScreen 
device.

Event Distribution Overview Displays the total number of event types occurring on all devices.
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GENERATING REPORTS AUTOMATICALLY
You can also create a report template or profile to generate a report(s) automatically. A 
report profile enables you to save all of the parameters that you have specified to generate 
a report. You can also schedule reports to be generated on a recurring basis. The 
Statistical Report Server will send you an e-mail notifying you when reports are available 
for viewing. You can later add, edit, or delete any of the tasks that you have defined in a 
profile.

Creating a Report Profile
1. Click on the Scheduler icon in the Statistical Reports Web Interface toolbar. 

This takes you to the Statistical Report Scheduler page.
2. Click on the Create Profile icon in the Statistical Report Scheduler toolbar. 

This takes you to the Task Profile - Create page.
3. Edit the Profile Name that appears in the Profile Name field to give your 

profile a name that you will remember easily.
4. Use the Reporting Window to specify the length of time that you want the 

report to cover. You can specify to generate a report for data occurring during 
the last n day(s), week(s), month(s), or quarter(s).

5. Specify a date and time when you want to start generating the report. 
6. Specify a date and time when you want to end generating the report.
7. Use the Category/Reports, Report Context, and Report Parameters panes to 

configure the report that you wish to generate.
8. Click on the Save icon in the Statistical Report Scheduler toolbar. A Create 

Profile Confirmation dialog appears indicating that the Statistical Report Server 
has saved your profile in the database.

The Report Profile now appears in the Statistical Report Scheduler page.

Scheduling a Report to Generate on a Recurring Basis
Use the Task Recurrence pull-down menu to select how often you would like to generate 
the report. You can choose to generate the report once only, hourly, daily, weekly, 
monthly, or quarterly.

Note: You may need to wait at least 30 seconds before tasks that you have 
configured in your profile begin.
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Enabling E-Mail Notification
Click the ON radio button if you want the Statistical Report Server to send you an e-mail 
indicating when the report has been generated.

Click the OFF radio button if you do not want the Statistical Report Server to send you an 
e-mail.

Editing a Report Profile
1. Click on the Edit icon corresponding to the profile name that you wish to edit. 

This takes you to the Task Profile - Edit page.
2. Edit any of the parameters that you previously configured for the profile.
3. Click on the Save icon in the Statistical Report Scheduler toolbar. A Create 

Profile Confirmation dialog appears indicating that the Statistical Report Server 
has updated your profile in the database.

Deleting a Report Profile
1. Click on the Delete icon corresponding to the profile name that you wish to 

delete. A dialog appears asking you whether you want to delete the profile or the 
selected task only.

2. Click to select the Profile radio button. If you select the Task radio button, the 
Statistical Report Server will delete only that specific task.

3. Click OK to confirm the deletion. A dialog appears confirming that you have 
deleted the profile and its associated tasks. The Profile and its associated tasks 
no longer appear in the Statistical Report Scheduler page.

Deleting a Report Task
To delete a specific report task, follow the same procedures to delete a report profile, but 
select the Task radio button when prompted.

Saving Report Data
The Statistical Report Server stores the generated report data files under a subdirectory 
in the installation directory on the Statistical Report Server (e.g. <installDir>/
reportServer/webapps/reports/data).

Note: For e-mail notification to work properly, you must have configured e-mail properties 
(i.e., SMTP Server, Sender’s E-Mail Address) on the Statistical Report Server; and for the 
user as well. The Statistical Report Server will send the e-mail notification to the address 
specified.
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If you would like to maintain a large history of generated reports, it is recommended that 
you change the location where the data is stored to a directory on a computer which can 
provide additional storage.

Viewing the Status of Report Tasks
To view the status of those tasks that you have configured in your report profiles, click on 
the Task Status icon in the Statistical Report Scheduler toolbar.

Use the Filter Pane that appears on the left side of the page to specify which tasks you 
wish to view. In the Tasks Pane, each task is listed by Profile Name, Scheduled Time, and 
Status. The status of each task is described as either Created, Running, or Completed.

Viewing Report Profile Tasks by Date
Use the calendar tool or enter a date in the Date field provided to view the status of report 
tasks scheduled on a specific date.

Viewing Report Status by Period
Use the Period pull-down menu to view the status of those tasks scheduled during a 
specific past or future time period. You can view the status of all tasks or only those tasks 
scheduled during the last or next day, week, month, or quarter.

Viewing Report Status by Completion Status
Use the Status pull-down menu to view created, running or completed tasks.

Viewing Report Status by Profile Name
Use the Profile pull-down menu to view those tasks related to a specific report profile.

Refreshing the Display
Click on the Refresh icon in the Statistical Report Scheduler toolbar to refresh the 
display.
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VIEWING REPORTS
When the Statistical Report Server has completed generating your report, the Status on 
the profile will change to “Completed”. Click on the Completed link to view the report.

The Statistical Report Server displays statistical report data in a tabular format by 
default. The Statistical Report Server also displays a summary indicating the total 
number of pages in the report, the current page that you are viewing, and the total rows 
that are displayed per page.

The Statistical Report Server also includes a Report Setting section displaying general 
information about the report including:

• Admin: Displays name and contact information of the user who generated the 
report.

• Device Group (if applicable): Displays associated device group.
• Device (if applicable): Displays general device information, including IP 

address and serial number.
• Report Hour Start/End (time): Displays the designated start/end time for the 

report.

Specifying the Number of Rows Displayed
You can specify the number of rows displayed per page by entering the number in the 
Rows Per Pages field and pressing Enter.

Using the Report Index
The Report Index enables you quick access to pages in your report that are specific to a 
node (i.e., device, user) by default. Double click on the plus or minus icons to move up and 
down through the nested nodes. A red arrow will appear on the left of the node that is 
currently displayed.

You can customize the Report Index to allow you quick access to any page in your report 
according to your own preference. For example, if you were only interested in accessing 
pages in your report that displayed data according to a specific date, you could customize 
the Report Index to display only date entries.

Customizing the Report Index
1. Click on the Customize icon in the Statistical Report Web Interface toolbar. 

Select Report Index. This takes you to the Customize Report Index page.
2. To add a specific node in the Report Index, click to select one of the nodes listed 

in the Available Nodes field and click on the right arrow. The selected node 
appears in the list of Selected Nodes.

3. To remove a specific node in the Report Index, click to select one of the nodes 
listed in the Selected Nodes field and click on the left arrow. The selected node 
appears in the list of Available Nodes.
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4. To change the order in which a specific node appears in the Report Index, click to 
select the node in the Selected Nodes field and click on the down or up arrow.

5. Click on the Set button when you are done. This takes you back to the Statistical 
Report page.

Hiding the Report Index
You can remove the Report Index Pane from the Report page by clicking on the Hide icon 
in the Statistical Reports Web Interface toolbar.

You can bring the Report Index Pane back by clicking on the Show icon in the Statistical 
Reports Web Interface toolbar.

Sorting Report Data
You can sort the data appearing in any column by clicking in the header of that column. 
Once you click on a column header, an arrow appears indicating the sort order.

You may also be able to sort the report data using different criteria depending on the 
specific report that you have generated.

Customizing Report Columns
You can also remove and then add back any column that appears in a report.

1. Click on the Customize icon in the Statistical Reports Web Interface toolbar. 
Select Table Details. This takes you to the Customize Table Details page.

2. To remove a specific column from the report, click to uncheck the checkbox 
corresponding to the display column that you want to remove.

3. To add a specific column from the report, click to check the checkbox 
corresponding to the display column that you want to remove.

4. Click on the Set button when you are done. This takes you back to the Statistical 
Report page.

Viewing Report Data Graphically
The Statistical Report Server also enables several graphical views of the data including:

• Bar chart
• 2D or 3D Bar - allowing you to view data in a 2- or 3-dimensional bar chart (only 

available with bar charts).
• Stacked Bar (only available with bar charts).
• Plot Chart
• Pie Chart

Use the Statistical Report toolbar to select the graphical view that you want.
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Viewing More Details
You can click on most of the data depicted graphically to drill-down and view the report in 
more detail.
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EXPORTING REPORTS
You can export reports to either an Adobe Acrobat (.pdf) or Microsoft Excel (.csv) file. 
When exporting to a .PDF file, only the current view is exported.

1. Click on the Export icon in the Statistical Reports Web Interface toolbar.
2. Select either PDF or CSV to specify the type of file you would like to export the 

data to. A dialog will appear prompting you to select either Open, Save, Cancel, 
More Information.

3. Click Save to export the file. Browse to the directory where you want the 
exported file saved. The Statistical Report Server generates the file and saves it 
in the directory you specified. A dialog will appear indicating that the file 
download was complete.

Note: Exporting a tabular report to a .PDF may take several minutes.
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4
Chapter 4

Managing the Statistical Report 
Server Database

In This Chapter

• “Managing the Database” on page 50
• “Purging the Database” on page 52

This chapter describes how to maintain the Statistical Report Server historical database. 
It describes how you can perform cleanup, archival, and purging procedures.
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MANAGING THE DATABASE
The Statistical Report Server enables you to perform basic maintenance on the size of the 
historical database by purging records automatically when the number of records per 
table reaches a certain specified limit.

It is also possible to configure the GUI Server to archive data that is purged.

Enabling Database Maintenance
You can configure the GUI Server to perform maintenance of the historical database from 
the Statistical Report Server-Administration Console:

1. Use the Tools menu and select DB Management. The DB Management 
window appears.

2. Click in the Enable Database Cleanup checkbox.
3. Enter the IP address of the GUI Server that you wish to perform the database 

clean-up operation.
4. Use the Clean-up database every pull-down menus to select the number of 

days between which as well as the time of day that you want the GUI Server to 
purge the database. The database purging interval is set to 1 day by default. For 
example, if you set the database purging interval to 2 days, the GUI Server 
purges the database every other day.

The database purging time is set to 1 (or 1:00am) by default. Note that you will 
need to enter the time in 24hour format (i.e., 1 would be 0100 hours or 1:00AM, 
13 would be 1300 hours or 1:00PM). It is recommended that you configure the 
GUI Server to perform the purging operation after working hours (for example, 
20 or 2000 hours or 8:00PM).

5. Click in the Number of records per table after clean-up field and enter the 
number of records per table that you wish to maintain after the purging 
operation. The number of records per table after purging is set to 1,000,000 by 
default. For example, if you did not want the database to exceed 500,000 records 
per table, you would set the number of records per table after purging to 500000. 
When the number of records per table exceeded this limit, the GUI Server will 
perform the purging operation.

Note: You will need administrative privileges to “Administer Database” to perform 
database cleanup operations.

Note: Use the Event Distribution Overview Report from the Statistical Reports 
Web Interface to view the current number of records per table in your database.

Warning: Be extremely careful when setting the number of records per table after 
purging. If you set this value to zero, you will instruct the GUI Server to purge all 
records from your database.
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6. Click OK to save your changes; click Cancel to cancel your changes.

Archiving Data Before Cleanup Operations
If you wish to archive data that is purged, you can configure the GUI Server to save the 
data in a specified location on the server.

To archive purged data:

1. Follow the same steps that you used to get to the DB Management window.
2. Click in the Archive records before clean-up checkbox.
3. Click in the Directory on GUI Server to archive records field and enter the 

path to the directory where you want to archive those records that are being 
removed from the database.

4. Click OK to save your changes; click Cancel to cancel your changes.

Viewing Status on the Last Database Cleanup 
Operation

To check the status of the last database cleanup operation, check the bottom pane of the 
DB Management window. The data and time of the last operation appears with the 
number of records removed.

Performance Considerations
The Statistical Report Server database maintenance features perform best when applied 
to a small to medium-sized database. If your database requires daily maintenance of more 
than a million records per day, using the database cleanup features is not recommended.

For example, if you are using a standard Oracle database server (on a Dell Poweredge 
4600 with 8 disks), and a Ultra 10 as the computer where you are running the GUI 
Server, you can expect a routine archiving operation of 950k records to take 
approximately 35 minutes; you can also expect a purging operation of 950k records to take 
approximately 10 minutes. Note that the total time required to purge data is not linearly 
proportional to the number of database records (e.g. archiving of 15M records takes > 12 
hrs).

Note: You cannot cancel a purging operation once it has begun.

Note: To ensure that you do not lose any new data inserted after archiving, the 
GUI Server will not purge any data from the current date, even if the current 
date's data is over the limit configured. 
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PURGING THE DATABASE
In the unlikely event that you need to restart the initialization of the database schema 
(for example, the GUI Server is unable to connect to the database during installation), you 
can run the following scripts to purge and reinitialize the database.

For Oracle:

glpro_orcl_drop_table.sql

For MS-SQL

glpro_mssql_drop_table.sql

For PostgreSQL:

glpro_pg_drop_table.sql
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